
Q .1Q .1 Whic h of the fo l lowing leaders  d id  NO T part ic ipate in the 1 857  M utiny ,  whic h isWhic h of the fo l lowing leaders  d id  NO T part ic ipate in the 1 857  M utiny ,  whic h is
c al led  the Firs t  War  of Ind ian Independence?c al led  the Firs t  War  of Ind ian Independence?

A nsA ns 1. General Bakht Khan

2. Alluri Sitarama Raju

3. Nana Saheb

4. Kunwar Singh

Q .2Q .2 Whic h of the fo l lowing c ountr ies  as s umed the c hairmans hip of BRIC S  in 2 0 24 ?Whic h of the fo l lowing c ountr ies  as s umed the c hairmans hip of BRIC S  in 2 0 24 ?

A nsA ns 1. Russia

2. India

3. South Africa

4. Brazil

Q .3Q .3 M atc h the fo l lowing organis at ions  with the y ears  in whic h they  were founded .M atc h the fo l lowing organis at ions  with the y ears  in whic h they  were founded .

a .  A ry a S amaj a .  A ry a S amaj i .  1 82 8i .  1 82 8
b.  Rama Kr is han M is s ion b.  Rama Kr is han M is s ion i i .  1 873i i .  1 873
c .  S aty as hodhak  S amaj c .  S aty as hodhak  S amaj i i i .  1 875i i i .  1 875
d .  Brahmo S amaj d .  Brahmo S amaj iv.  1 897iv.  1 897

A nsA ns 1. a-iv; b-i; c-iii; d-ii

2. a-i; b-ii; c-iii; d-iv

3. a-iii; b-iv; c-ii; d-i

4. a-ii; b-iv; c-i; d-iii
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Q .4Q .4 The National  E duc at ion Pol ic y  was  framed in __________ and firs t  modified inThe National  E duc at ion Pol ic y  was  framed in __________ and firs t  modified in
__________ .__________ .

A nsA ns 1. 1984; 1995

2. 1982; 1991

3. 1980; 1992

4. 1986; 1992

Q . 5Q . 5 The 2 0 1 1  C ens us  data reveals  that  ______ ,  with a  populat ion of 1 99 mil l ion,  is  theThe 2 0 1 1  C ens us  data reveals  that  ______ ,  with a  populat ion of 1 99 mil l ion,  is  the
mos t populous  s tate in Ind ia .mos t  populous  s tate in Ind ia .

A nsA ns 1. Bihar

2. Maharashtra

3. Rajasthan

4. Uttar Pradesh

Q .6Q .6 Whic h Indian defence organis at ion developed a high- pres s ure nanoporousWhic h Indian defence organis at ion developed a high- pres s ure nanoporous
mult i lay ered poly meric  membrane for  s eawater  des al inat ion,  addres s ing themult i lay ered poly meric  membrane for  s eawater  des al inat ion,  addres s ing the
operat ional  needs  of the Indian C oas t  G uard in 2 0 2 5?operat ional  needs  of the Indian C oas t  G uard in 2 0 2 5?

A nsA ns 1. Defence Research and Development Organisation

2. Hindustan Aeronautics Limited

3. Indian Space Research Organisation

4. Bharat Heavy Electricals Limited

Q .7Q .7 Whic h of the fo l lowing was  the firs t  Telugu dy nas ty  to  rule S outh India  for  moreWhic h of the fo l lowing was  the firs t  Telugu dy nas ty  to  rule S outh India  for  more
than 4 0 0  y ears?than 4 0 0  y ears?

A nsA ns 1. Satavahana dynasty

2. Rashtrakuta dynasty

3. Bahmanī sultanate

4. Kakatiya dynasty
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Q .8Q .8 Whic h of the fo l lowing s tatements  is  INCO RRE C T with res pec t  to  the IndianWhic h of the fo l lowing s tatements  is  INCO RRE C T with res pec t  to  the Indian
Par l iament?Par l iament?

A nsA ns 1. The President can summon and prorogue the Parliament.

2. The first elected Parliament came into existence in April 1954.

3. The Parliament is a legislative body at the Union level.

4. The Parliament has two houses.

Q .9Q .9 Whic h of the fo l lowing regions  is  known for  its  geothermal energy  projec t?Whic h of the fo l lowing regions  is  known for  its  geothermal energy  projec t?

A nsA ns 1. Kangra Valley

2. Gulf of Kutch

3. Ganga valley

4. Puga Valley

Q .1 0Q .1 0 In the Indian Par l iament ,  the proceedings  of the Par l iament begins  with theIn the Indian Par l iament ,  the proceedings  of the Par l iament begins  with the
________ .________ .

A nsA ns 1. zero hour

2. question hour

3. discussion hour

4. welcome hour

Q .1 1Q .1 1 Under  the PM  V idy alaxmi s c heme launc hed in November 2 0 24 ,  how muc hUnder  the PM  V idy alaxmi s c heme launc hed in November 2 0 24 ,  how muc h
maximum loan amount wi l l  be provided to  meritor ious  s tudents?maximum loan amount wi l l  be provided to  meritor ious  s tudents?

A nsA ns 1. Upto ₹7.5 lakh

2. Upto ₹4.5 lakh

3. Upto ₹5.5 lakh

4. Upto ₹8.5 lakh

Q .1 2Q .1 2 Who was  the V iceroy  of Br it is h India  dur ing the G overnment of Ind ia  A c t  1 91 9?Who was  the V iceroy  of Br it is h India  dur ing the G overnment of Ind ia  A c t  1 91 9?

A nsA ns 1. 

2. 

3. 

4. 
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Q .1 3Q .1 3 In 2 0 1 9 ,  the total  number of judges  in the S upreme C ourt  was  fixed at  ____ ,In 2 0 1 9 ,  the total  number of judges  in the S upreme C ourt  was  fixed at  ____ ,
inc luding the C hief Jus t ice of Ind ia .inc luding the C hief Jus t ice of Ind ia .

A nsA ns 1. 25

2. 27

3. 30

4. 34

Q .1 4Q .1 4 In whic h s tate is  the Kamet peak  loc ated?In whic h s tate is  the Kamet peak  loc ated?

A nsA ns 1. Maharashtra

2. Kerala

3. Sikkim

4. Uttarakhand

Q .1 5Q .1 5 During the 2 0 2 5 World  Health A s s embly  in G eneva,  whic h of the fo l lowing majorDuring the 2 0 2 5 World  Health A s s embly  in G eneva,  whic h of the fo l lowing major
global  health developments  took  place?global  health developments  took  place?

A nsA ns 1. Launch of the One Health Initiative

2. Establishment of the International Public Health Court

3. Adoption of the world’s first global pandemic treaty

4. Adoption of the Global Antimicrobial Resistance Framework

Q .1 6Q .1 6 What was  the objec t ive of the ‘L ok  S amvardhan Parv ’ inaugurated by  the UnionWhat was  the objec t ive of the ‘L ok  S amvardhan Parv ’ inaugurated by  the Union
M inis ter  of  M inor ity  A ffairs?M inis ter  of  M inor ity  A ffairs?

A nsA ns 1. To promote traditional art under tribal development programmes

2. To showcase achievements of the Ministry under the 100 days’ plan

3. To provide free health check-ups to minority communities

4. To launch new educational scholarships for women and children

Q .1 7Q .1 7 Whic h A rt ic le of  the Indian C ons t itut ion mentions  that  the M oney  B i l l  s hal l  NO TWhic h A rt ic le of  the Indian C ons t itut ion mentions  that  the M oney  B i l l  s hal l  NO T
be introduced in the C ounc i l  of  S tates?be introduced in the C ounc i l  of  S tates?

A nsA ns 1. 109

2. 108

3. 111

4. 110
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Q .1 8Q .1 8 In whic h S tate of Ind ia  is  Karaivett i  B ird  S anc tuary  loc ated?In whic h S tate of Ind ia  is  Karaivett i  B ird  S anc tuary  loc ated?

A nsA ns 1. Madhya Pradesh

2. Gujarat

3. Tamil Nadu

4. Maharashtra

Q .1 9Q .1 9 Whic h of the fo l lowing batt les  was  won by  L ord C l ive over  the Nawab of Bengal  inWhic h of the fo l lowing batt les  was  won by  L ord C l ive over  the Nawab of Bengal  in
1 757?1 757?

A nsA ns 1. Battle of Buxar

2. Battle of Murshidabad

3. Battle of Arcot

4. Battle of Plassey

Q .2 0Q .2 0 Who among the fo l lowing was  appointed as  the new head c oac h of the IndianWho among the fo l lowing was  appointed as  the new head c oac h of the Indian
M en's  C r ic ket  Team in July  2 0 24 ?M en's  C r ic ket  Team in July  2 0 24 ?

A nsA ns 1. Gautam Gambhir

2. Ravi Shastri

3. Rahul Dravid

4. Ajit Agarkar

Q .2 1Q .2 1 What wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i fWhat wi l l  c ome in the place of the ques t ion mark  ( ? )  in the fo l lowing equation,  i f
‘+ ’ and ‘−’ are interc hanged,  and ‘× ’ and ‘÷ ’ are interc hanged?‘+’ and ‘−’ are interc hanged,  and ‘× ’ and ‘÷ ’ are interc hanged?

2 0  ÷  5 – 3 2  ×  4  + 6  = ?2 0  ÷  5 – 3 2  ×  4  + 6  = ?

A nsA ns 1. 102

2. 162

3. 142

4. 132

Section : Logical Reasoning
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Q .2 2Q .2 2 S elec t  the option figure that  wi l l  replace the ques t ion mark  ( ? )  in the figureS elec t  the option figure that  wi l l  replace the ques t ion mark  ( ? )  in the figure
given below to  c omplete the pattern.given below to  c omplete the pattern.

A nsA ns 1. 

2. 

3. 

4. 

Q .2 3Q .2 3 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l lRefer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l l
numbers  are s ingle- d igit  numbers  only . )numbers  are s ingle- d igit  numbers  only . )
( L eft)  1  5 3  7  2  8  4  9  6  1  3  7  5 4  2  8  9  6  3  7  1  5 4  9  8  2  6  ( Right)( L eft)  1  5 3  7  2  8  4  9  6  1  3  7  5 4  2  8  9  6  3  7  1  5 4  9  8  2  6  ( Right)

How many  t imes  does  the number ‘5’ appear  in the given s er ies?How many  t imes  does  the number ‘5’ appear  in the given s er ies?

A nsA ns 1. Three

2. Two

3. None

4. Four
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Q .24Q .24 Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-Bas ed on the E ngl is h a lphabetic al  order,  three of the fo l lowing four  letter-
c lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus terc lus ters  are a l ike in a  certain way  and thus  form a group.  Whic h letter- c lus ter
DO E S  NO T belong to  that  group?DO E S  NO T belong to  that  group?
( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or( Note:  The odd one out is  not  bas ed on the number of c ons onants/vowels  or
their  pos it ion in the letter- c lus ter. )their  pos it ion in the letter- c lus ter. )

A nsA ns 1. DHE

2. ORP

3. SVT

4. BEC

Q .2 5Q .2 5 If  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in theIf  1  is  added to  eac h odd d igit  and 2  is  s ubtrac ted from eac h even d igit  in the
number 1 783 4 2 6,  then what wi l l  be the produc t  of the d igits  whic h are s ec ondnumber 1 783 4 2 6,  then what wi l l  be the produc t  of the d igits  whic h are s ec ond
from the left  and third  from the r ight  in the new number thus  formed?from the left  and third  from the r ight  in the new number thus  formed?

A nsA ns 1. 18

2. 14

3. 16

4. 12

Q .2 6Q .2 6 NG  1 3  is  related to  O I  −1  in a  certain way .  In the s ame way ,  FL  1 9  is  related to  G NNG  1 3  is  related to  O I  −1  in a  certain way .  In the s ame way ,  FL  1 9  is  related to  G N
5.  To  whic h of the given options  is  UI  2 2  related ,  fo l lowing the s ame logic ?5.  To  whic h of the given options  is  UI  2 2  related ,  fo l lowing the s ame logic ?

A nsA ns 1. VL 12

2. UL 12

3. VK 8

4. UK 8
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Q .2 7Q .2 7 Three of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form aThree of the fo l lowing four  word- pairs  are a l ike in a  certain way  and thus  form a
group.  Whic h word- pair  DO E S  NO T belong to  that  group?group.  Whic h word- pair  DO E S  NO T belong to  that  group?

( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not( NO TE :  The words  mus t be c ons idered as  meaningful  E ngl is h words  and mus t not
be related to  eac h other  bas ed on the number of letters  /number ofbe related to  eac h other  bas ed on the number of letters  /number of
c ons onants/vowels  in the word . )c ons onants/vowels  in the word . )

A nsA ns 1. Active : Lazy

2. Beautiful :  Ugly

3. Bitter : Sour

4. After : Before

Q .2 8Q .2 8 E ac h vowel  in the word NE WS PA PE R is  c hanged to  the letter  immediatelyE ac h vowel  in the word NE WS PA PE R is  c hanged to  the letter  immediately
fo l lowing it  in the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged tofo l lowing it  in the E ngl is h a lphabetic al  order  and eac h c ons onant is  c hanged to
the letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  How manythe letter  immediately  preceding it  in the E ngl is h a lphabetic al  order.  How many
letters  wi l l  appear  exac t ly  twice in the group of letters  thus  formed?letters  wi l l  appear  exac t ly  twice in the group of letters  thus  formed?

A nsA ns 1. None

2. Two

3. Three

4. One

Q .2 9Q .2 9 JUM PE R is  related to  Q FNKV I  in a  certain way  bas ed on the E ngl is h a lphabetic alJUM PE R is  related to  Q FNKV I  in a  certain way  bas ed on the E ngl is h a lphabetic al
order.  In the s ame way ,  CO L LUS IO N is  related to  XLO O FHRL M .  To whic h of theorder.  In the s ame way ,  CO L LUS IO N is  related to  XLO O FHRL M .  To whic h of the
given options  is  M A RKE T related ,  fo l lowing the s ame logic ?  given options  is  M A RKE T related ,  fo l lowing the s ame logic ?  

A nsA ns 1. 

2. 

3. 

4. 
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Q .3 0Q .3 0 S ix  people U,  V,  W,  X ,  F  and G  are s itt ing around a c irc ular  table fac ing the centreS ix  people U,  V,  W,  X ,  F  and G  are s itt ing around a c irc ular  table fac ing the centre
of the table.  O nly  V  s its  between G  and W.  of  the table.  O nly  V  s its  between G  and W.  W s its  third  to  the left  of  U.  F  s its  toW s its  third  to  the left  of  U.  F  s its  to
the immediate left  of  U.  How many  people s it  between X and F when c ountedthe immediate left  of  U.  How many  people s it  between X and F when c ounted
from the r ight  of F?from the r ight  of F?

A nsA ns 1. Four

2. Three

3. One

4. Two

Q .3 1Q .3 1 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

1 5 1 5 3 2  3 2  53  53  81  81  1 1 3  1 1 3  ??

A nsA ns 1. 150

2. 153

3. 151

4. 152

Q .3 2Q .3 2 What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?What s hould  c ome in place of the ques t ion mark  ( ? )  in the given s er ies?

3 2 ,  3 7,  47,  62 ,  82 ,  ?3 2 ,  3 7,  47,  62 ,  82 ,  ?

A nsA ns 1. 108

2. 109

3. 107

4. 106
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Q .3 3Q .3 3 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l lRefer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l l
numbers  are s ingle- d igit  numbers  only . )numbers  are s ingle- d igit  numbers  only . )
( L eft)  1  5 3  7  2  8  4  9  6  1  3  7  5 4  2  8  9  6  3  7  1  5 4  9  8  2  6  ( Right)( L eft)  1  5 3  7  2  8  4  9  6  1  3  7  5 4  2  8  9  6  3  7  1  5 4  9  8  2  6  ( Right)

How many  t imes  do two or  more perfec t  s quare numbers  appear  immediatelyHow many  t imes  do two or  more perfec t  s quare numbers  appear  immediately
next  to  eac h other  in the given s er ies?next  to  eac h other  in the given s er ies?

A nsA ns 1. Two

2. Four

3. None

4. Three

Q .3 4Q .3 4 There are s ix  members  in a  family  – P,  Q ,  R,  S,  T,  and U.There are s ix  members  in a  family  – P,  Q ,  R,  S,  T,  and U.
Q  and R are marr ied .  S  is  the only  s on of R.  R is  the s on of U.  U is  the hus band ofQ  and R are marr ied .  S  is  the only  s on of R.  R is  the s on of U.  U is  the hus band of
P.  T  is  the mother  of U.P.  T  is  the mother  of U.
How is  P  related to  T?How is  P  related to  T?

A nsA ns 1. Son’s wife

2. Wife

3. Mother

4. Daughter

Q .3 5Q .3 5 S elec t  the s et  in whic h the numbers  are related in the s ame way  as  are theS elec t  the s et  in whic h the numbers  are related in the s ame way  as  are the
numbers  of the fo l lowing s ets .numbers  of the fo l lowing s ets .

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding/s ubtrac t ing/mult iply ing etc .  to  1 3,  c an be performed.  Break ing downas  adding/s ubtrac t ing/mult iply ing etc .  to  1 3,  c an be performed.  Break ing down
1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not1 3  into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )a l lowed . )

( 7,  3,  1 5)( 7,  3,  1 5)
( 8 ,  8 ,  2 1 )( 8 ,  8 ,  2 1 )

A nsA ns 1. (8, 12, 22)

2. (12, 4, 23)

3. (26, 5, 61)

4. (4, 18, 27)
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Q .3 6Q .3 6 If  ‘R ’ s tands  for  ‘÷ ’ ,  ‘S ’ s tands  for  ‘× ’ ,  ‘T ’ s tands  for  ‘+ ’ ,  and ‘U ’ s tands  for  ‘− ’ ,  thenIf  ‘R ’ s tands  for  ‘÷ ’ ,  ‘S ’ s tands  for  ‘× ’ ,  ‘T ’ s tands  for  ‘+ ’ ,  and ‘U ’ s tands  for  ‘− ’ ,  then
the res ultant  of whic h of the fo l lowing would  be 1 1 2 ?the res ultant  of whic h of the fo l lowing would  be 1 1 2 ?

A nsA ns 1. 64 R 2 U 16 T 8 S 4

2. 96 S 1 R 3 U 24 T 4

3. 80 T 40 U 8 S 2 R 2

4. 70 U 38 T 10 R 2 S 1

Q .3 7Q .3 7 In the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ingIn the fo l lowing number- pairs ,  the s ec ond number is  obtained by  apply ing
certain mathematic al  operat ions  to  the firs t  number.  Whic h numbers  s houldcertain mathematic al  operat ions  to  the firs t  number.  Whic h numbers  s hould
replace X  and Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s idereplace X  and Y,  s o  that  the pattern fo l lowed by  the two numbers  on the left  s ide
of : :  is  s ame as  that  on the r ight  s ide of : : ?of : :  is  s ame as  that  on the r ight  s ide of : : ?

( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing( NO TE :  O perat ions  s hould  be performed on the whole numbers ,  without break ing
down the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc hdown the numbers  into  their  c ons t ituent d igits .  E .g .  1 3  – O perat ions  on 1 3  s uc h
as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3as  adding/s ubtrac t ing/mult iply ing to  1 3  c an be performed.  Break ing down 1 3
into  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  notinto  1  and 3  and then performing mathematic al  operat ions  on 1  and 3  is  not
al lowed . )a l lowed . )

X  :  1 2 7  : :  56  :  YX :  1 2 7  : :  56  :  Y

A nsA ns 1. X = 41, Y = 168

2. X = 42, Y = 169

3. X = 42, Y = 157

4. X = 32, Y = 167

Q .3 8Q .3 8 Refer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l lRefer  to  the fo l lowing number s er ies  and ans wer  the ques t ion that  fo l lows .  ( A l l
numbers  are s ingle- d igit  numbers  only . )numbers  are s ingle- d igit  numbers  only . )

( L eft)  ( L eft)  4  4  4  4  7  7  5 5 2  2  4  4  7  7  9  9  8  8  3  3  2  2  6  6  9  9  5 5 8  8  4  4  9  9  8  8  2  2  4  4  5 5 5 5 9  9  2  2  8  8  3  3  8  8  ( Right)( Right)

If  a l l  the odd numbers  are dropped from the s er ies ,  whic h number wi l l  be s ec ondIf  a l l  the odd numbers  are dropped from the s er ies ,  whic h number wi l l  be s ec ond
from the r ight?from the r ight?

A nsA ns 1. 8

2. 6

3. 2

4. 4
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https://applink.adda247.com/d/XhqWf9lSap


Q .3 9Q .3 9 S Q 1 2 1  is  related to  NL 2 2 0  in a  certain way .  In the s ame way ,  IG 1 98 is  related toS Q 1 2 1  is  related to  NL 2 2 0  in a  certain way .  In the s ame way ,  IG 1 98 is  related to
DB2 97.  To  whic h of the given options  is  L J2 99 related ,  fo l lowing the s ame logic ?DB2 97.  To  whic h of the given options  is  L J2 99 related ,  fo l lowing the s ame logic ?

A nsA ns 1. G F397

2. GE398

3. FD398

4. FH397

Q .4 0Q .4 0 U,  V,  W,  X ,  and Y  are s itt ing on a benc h,  fac ing north.  U and V  are immediateU,  V,  W,  X ,  and Y  are s itt ing on a benc h,  fac ing north.  U and V  are immediate
neighbours .  W and X are immediate neighbours .  V  and X are immediateneighbours .  W and X are immediate neighbours .  V  and X are immediate
neighbours  of Y,  whi le Y  s its  to  the immediate r ight  of X .neighbours  of Y,  whi le Y  s its  to  the immediate r ight  of X .
Who s its  on the extreme r ight end of the benc h?Who s its  on the extreme r ight end of the benc h?

A nsA ns 1. V

2. U

3. W

4. X

Q .4 1Q .4 1 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given groupS elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group
of words .of  words .

The art  of  beautiful  handwrit ingThe art  of  beautiful  handwrit ing

A nsA ns 1. Cacography

2. Calligraphy

3. Cartography

4. Choreography

Q .4 2Q .4 2 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

Hik ing is  d iffic ult  ________ fun.Hik ing is  d iffic ult  ________ fun.

A nsA ns 1. therefore

2. so

3. or

4. but

Section : General English and Comprehension
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Q .43Q .43 S elec t  the mos t appropr iate s y nony m of the given word .S elec t  the mos t appropr iate s y nony m of the given word .

E ternalE ternal

A nsA ns 1. Fleeting

2. Temporary

3. Fragile

4. Enduring

Q .4 4Q .4 4 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .
S he ___ to  s c hool  every  day .S he ___ to  s c hool  every  day .

A nsA ns 1. gone

2. go

3. goes

4. going

Q .4 5Q .4 5 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.

Bac k  to  s quare oneBac k  to  s quare one

A nsA ns 1. One should be aware of a potential danger to protect oneself

2. When one is in a difficult situation

3. When one plans to do something because of the other plan

4. When one takes a new course of action after a failed one

https://applink.adda247.com/d/XhqWf9lSap
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and
tiredness.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6

Q .4 6Q .4 6 Why  is  iron required by  the body ?Why  is  iron required by  the body ?

A nsA ns 1. To strengthen bones and teeth

2. To aid in the digestion of food

3. To transport oxygen to its various parts

4. To regulate blood sugar levels
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and
tiredness.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47

Q .47Q .47 Who enc ourages  their  c l ients  to  inc lude power foods  in their  dai ly  d iet?Who enc ourages  their  c l ients  to  inc lude power foods  in their  dai ly  d iet?

A nsA ns 1. Nutritionists

2. Doctors

3. Fitness trainers

4. Dieticians
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and
tiredness.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8

Q .4 8Q .4 8 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

ProvideProvide

A nsA ns 1. Furnish

2. Reserve

3. Pursue

4. Supply
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and
tiredness.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9

Q .4 9Q .4 9 What are power foods  r ic h in?What are power foods  r ic h in?

A nsA ns 1. Processed ingredients and artificial flavours

2. Fibre, potassium, and minerals

3. Sugars, fats, and carbohydrates

4. Proteins, vitamins, and antioxidants
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C omprehens ion:C omprehens ion:

Read the given passage carefully and answer the questions that follow.

Power foods are foods that provide rich levels of nutrients such as fibre, potassium, and
minerals. With people becoming increasingly health-conscious today, a lot of fitness
trainers encourage their clients to include these foods in their daily diet to increase
muscle development. There are various ways of incorporating power foods into your daily
diet. Of course, the key to enjoying power foods is proper preparation of these foods, the
use of seasonally fresh foods, and identifying your choice of flavour among power foods.
Some of the recommended power food combinations are those that are prepared in our
kitchens on a regular basis. Take for instance, the combination of chickpeas and onions.
This combination is a powerful source of iron, which is required by the body to transport
oxygen to its various parts. Iron deficiency can lead to anaemia, fatigue, brain fog, and
tiredness.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50

Q . 50Q . 50 Whic h of the fo l lowing c an be the s uitable t it le for  the pas s age?Whic h of the fo l lowing c an be the s uitable t it le for  the pas s age?

A nsA ns 1. Fitness and Diet: A Trainer's Guide to Muscle Development

2. Simple Steps to Prepare Delicious and Healthy Meals

3. The Importance of Iron in Our Daily Diet

4. Unlocking the Power of Nutrient-Rich Foods

Section : General Hindi and Comprehension
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Q . 51Q . 51 '' सौसौ   सया नेसया ने   एकएक   मतमत '  '  लो को deलो को de   काका   अथhअथh   हैहै --

A nsA ns 1. एक सयाना सौ के बराबर

2. सौ सयाने एकमत नहm होते

3. बुopमान एकमत होकर कायh करते हq

4. एक मत सौ के बराबर

Q . 52Q . 52 ‘‘ rचरा गrचरा ग   त लेत ले   अंधेराअंधेरा ’ ’ लो को deलो को de   काका   wाwा   अथhअथh   हैहै ??

A nsA ns 1. पास कy चीज |दखाई न पड़ना

2. हर तरफ़ अंधेरा होना

3. अँधेरे म� rचराग जलाना

4. शाम होते ही सोने लगना

Q . 53Q . 53 '' ऐ� यhऐ� यh '  '  काका   �वलो म�वलो म   श�श�   wाwा   हैहै --

A nsA ns 1. दा�र�य

2. �वकyणh

3. देव

4. दानी

Q . 54Q . 54 '' अ� �अ� � ' '  काका   �वलो म�वलो म   श�श�   हो गाहो गा  - -

A nsA ns 1. बहु�

2. अ�ायु

3. अ�धक

4. जंगल

Q . 55Q . 55 ि� याि� या   काका   उ rचतउ rचत   � प� प   �र e�र e   �ा न�ा न   म�म�   भर�भर� --
गो पा लगो पा ल   नेने   उ सेउ से  - - -   - - -  |द या|द या ।।

A nsA ns 1. सुलाना

2. जगा

3. उठाना

4. जगान
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C omprehens ion:C omprehens ion:

|दए गए ग��श के आधार पर �न��िकत ��� के उ�र दी जए--
लोकतं¡ का इ�तहास यूनान के नगर रा¤� से शु� हुआ। अर¥ु ने लोकतं¡ के संय�मत ¦�प को उ�म माना है।
यूनान के नगर रा¤� म� �§¨ लोकतं¡ था। सभी ¦तं¡ ©de आम सभा म� एक¡ होते, क़ानून बनाते और उ¬� लागू
करते थे। भारत म� �ाचीन काल से ही गणत�ि¡क ©व�ा रही है। यह­  ल®वी, वैशाली आ|द गणतं¡� का उ¯ेख
�मलता है। चोल� के समय �ानीय ¦शासन उस काल कy अनूठ° �वशेषता थी जह­ ²ाम सभा म� सभी पु³ष इक´े
होकर शासन संबंधी �नयम क़ानून बनाते और लागू करते थे। मµ युग म� पुन: लोकतं¡ का ज¶ इटली के नगर
रा¤� म� हुआ। ¸¦टज़रलैº के फारे¼ कq टन� म� भी �§¨ लोकतं¡ था जो आज भी है। अठाहरवm शता�ी म� �सो
ने इस �कार के शासन का समथhन िकया था। �सो अ�§¨ अथवा ��त�नधा½क लोकतं¡ को बुरा मानता था।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56

Q . 56Q . 56 � सो� सो   िक सिक स   � का र� का र   केके   लो क तं¡लो क तं¡   कोको   अ®ाअ®ा   मा नतामा नता   हैहै - -- -

A nsA ns 1. राजतं¡

2. �§¨ लोकतं¡

3. अ�§¨ लोकतं¡

4. ��त�नधा½क लोकतं¡

C omprehens ion:C omprehens ion:

|दए गए ग��श के आधार पर �न��िकत ��� के उ�र दी जए--
लोकतं¡ का इ�तहास यूनान के नगर रा¤� से शु� हुआ। अर¥ु ने लोकतं¡ के संय�मत ¦�प को उ�म माना है।
यूनान के नगर रा¤� म� �§¨ लोकतं¡ था। सभी ¦तं¡ ©de आम सभा म� एक¡ होते, क़ानून बनाते और उ¬� लागू
करते थे। भारत म� �ाचीन काल से ही गणत�ि¡क ©व�ा रही है। यह­  ल®वी, वैशाली आ|द गणतं¡� का उ¯ेख
�मलता है। चोल� के समय �ानीय ¦शासन उस काल कy अनूठ° �वशेषता थी जह­ ²ाम सभा म� सभी पु³ष इक´े
होकर शासन संबंधी �नयम क़ानून बनाते और लागू करते थे। मµ युग म� पुन: लोकतं¡ का ज¶ इटली के नगर
रा¤� म� हुआ। ¸¦टज़रलैº के फारे¼ कq टन� म� भी �§¨ लोकतं¡ था जो आज भी है। अठाहरवm शता�ी म� �सो
ने इस �कार के शासन का समथhन िकया था। �सो अ�§¨ अथवा ��त�नधा½क लोकतं¡ को बुरा मानता था।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57

Q . 57Q . 57 लो क तं¡लो क तं¡   केके   इ�त हा सइ�त हा स   काका   �ा र ¾�ा र ¾   क ह­क ह­   सेसे   मा नामा ना   जाजा   सक तासक ता   हैहै - -- -

A nsA ns 1. यूनान के नगर रा¤� से

2. ¸¦टज़रलैº के फारे¼ कq टनो से

3. भारत के वैशाली आ|द गणरा¤� से

4. चोल� के �ानीय ¦शासन से
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C omprehens ion:C omprehens ion:

|दए गए ग��श के आधार पर �न��िकत ��� के उ�र दी जए--
लोकतं¡ का इ�तहास यूनान के नगर रा¤� से शु� हुआ। अर¥ु ने लोकतं¡ के संय�मत ¦�प को उ�म माना है।
यूनान के नगर रा¤� म� �§¨ लोकतं¡ था। सभी ¦तं¡ ©de आम सभा म� एक¡ होते, क़ानून बनाते और उ¬� लागू
करते थे। भारत म� �ाचीन काल से ही गणत�ि¡क ©व�ा रही है। यह­  ल®वी, वैशाली आ|द गणतं¡� का उ¯ेख
�मलता है। चोल� के समय �ानीय ¦शासन उस काल कy अनूठ° �वशेषता थी जह­ ²ाम सभा म� सभी पु³ष इक´े
होकर शासन संबंधी �नयम क़ानून बनाते और लागू करते थे। मµ युग म� पुन: लोकतं¡ का ज¶ इटली के नगर
रा¤� म� हुआ। ¸¦टज़रलैº के फारे¼ कq टन� म� भी �§¨ लोकतं¡ था जो आज भी है। अठाहरवm शता�ी म� �सो
ने इस �कार के शासन का समथhन िकया था। �सो अ�§¨ अथवा ��त�नधा½क लोकतं¡ को बुरा मानता था।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58

Q . 58Q . 58 �न��न�   म�म�   सेसे   � § ¨� § ¨   काका   �वलो म�वलो म   श�श�   हैहै - -- -

A nsA ns 1. अन�§¨

2. अव�§¨

3. �व�§¨

4. अ�§¨

C omprehens ion:C omprehens ion:

|दए गए ग��श के आधार पर �न��िकत ��� के उ�र दी जए--
लोकतं¡ का इ�तहास यूनान के नगर रा¤� से शु� हुआ। अर¥ु ने लोकतं¡ के संय�मत ¦�प को उ�म माना है।
यूनान के नगर रा¤� म� �§¨ लोकतं¡ था। सभी ¦तं¡ ©de आम सभा म� एक¡ होते, क़ानून बनाते और उ¬� लागू
करते थे। भारत म� �ाचीन काल से ही गणत�ि¡क ©व�ा रही है। यह­  ल®वी, वैशाली आ|द गणतं¡� का उ¯ेख
�मलता है। चोल� के समय �ानीय ¦शासन उस काल कy अनूठ° �वशेषता थी जह­ ²ाम सभा म� सभी पु³ष इक´े
होकर शासन संबंधी �नयम क़ानून बनाते और लागू करते थे। मµ युग म� पुन: लोकतं¡ का ज¶ इटली के नगर
रा¤� म� हुआ। ¸¦टज़रलैº के फारे¼ कq टन� म� भी �§¨ लोकतं¡ था जो आज भी है। अठाहरवm शता�ी म� �सो
ने इस �कार के शासन का समथhन िकया था। �सो अ�§¨ अथवा ��त�नधा½क लोकतं¡ को बुरा मानता था।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59

Q . 59Q . 59 अर ¥ूअर ¥ू   नेने   िक सिक स   रा ¤रा ¤   � णा ली� णा ली   कोको   सव¿ � मसव¿ � म   मा नामा ना   हैहै - -- -

A nsA ns 1. अ�धनायकतं¡

2. लोकतं¡

3. राजतं¡

4. धमhतं¡
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C omprehens ion:C omprehens ion:

|दए गए ग��श के आधार पर �न��िकत ��� के उ�र दी जए--
लोकतं¡ का इ�तहास यूनान के नगर रा¤� से शु� हुआ। अर¥ु ने लोकतं¡ के संय�मत ¦�प को उ�म माना है।
यूनान के नगर रा¤� म� �§¨ लोकतं¡ था। सभी ¦तं¡ ©de आम सभा म� एक¡ होते, क़ानून बनाते और उ¬� लागू
करते थे। भारत म� �ाचीन काल से ही गणत�ि¡क ©व�ा रही है। यह­  ल®वी, वैशाली आ|द गणतं¡� का उ¯ेख
�मलता है। चोल� के समय �ानीय ¦शासन उस काल कy अनूठ° �वशेषता थी जह­ ²ाम सभा म� सभी पु³ष इक´े
होकर शासन संबंधी �नयम क़ानून बनाते और लागू करते थे। मµ युग म� पुन: लोकतं¡ का ज¶ इटली के नगर
रा¤� म� हुआ। ¸¦टज़रलैº के फारे¼ कq टन� म� भी �§¨ लोकतं¡ था जो आज भी है। अठाहरवm शता�ी म� �सो
ने इस �कार के शासन का समथhन िकया था। �सो अ�§¨ अथवा ��त�नधा½क लोकतं¡ को बुरा मानता था।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60

Q .60Q .60 चो ल�चो ल�   केके   �ा नी य�ा नी य   ¦शा सन¦शा सन   कyकy   �वशेष ता�वशेष ता   थीथी - -- -

A nsA ns 1. ²ाम सभा म� सभी पु³ष इक´े होकर क़ानून बनाते थे

2. क़ानून बनाने के  लए चुनाव के माµम से स�म�तय­ चुनी जाती थी

3. ग­व� के उÀ वगh के लोग स�म�त चुनते थे जो क़ानून बनाती थी

4. ²ाम सभा म� सभी Áी-पु³ष इक´े होकर क़ानून बनाते थे

Q .61Q .61 In M S  PowerPoint ,  how c an y ou al ign text  within a  text  box?In M S  PowerPoint ,  how c an y ou al ign text  within a  text  box?

A nsA ns 1. By applying custom animations to the text

2. By dragging the text box to a different position on the slide

3. By using the 'Slide Master' view

4. By selecting the text and choosing alignment options from the Home tab

Section : Basic Knowledge of Computer
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Q .62Q .62 In M S  Word ,  y ou need to  perform advanced text  ed it ing on a large doc ument .In M S  Word ,  y ou need to  perform advanced text  ed it ing on a large doc ument .
This  inc ludes  finding and replac ing s pec ific  text  with d ifferent formatt ing as  wel lThis  inc ludes  finding and replac ing s pec ific  text  with d ifferent formatt ing as  wel l
as  us ing s pec ia l  c harac ters  and wi ldc ards .  Whic h of the fo l lowing s teps  s houldas  us ing s pec ia l  c harac ters  and wi ldc ards .  Whic h of the fo l lowing s teps  s hould
y ou fo l low to  ac hieve this?y ou fo l low to  ac hieve this?

A nsA ns 1. Go to the File tab, select Options, and enable advanced text editing features.

2. Go to the Home tab, select Replace, click More in the Find and Replace dialog box,
and use Format and Special options along with wildcards.

3. Go to the Home tab, select Find, and use the Replace option to change text and
formatting.

4. Go to the Review tab, select Advanced Find, and use the Replace option to change
text and formatting.

Q .63Q .63 What does  the term ' latenc y '  refer  to  in a  WA N c ontext?What does  the term ' latenc y '  refer  to  in a  WA N c ontext?

A nsA ns 1. The amount of data that can be transmitted

2. The speed of the network

3. The security of the network

4. The delay between sending and receiving data

Q .64Q .64 What happens  when an email  in the O utbox is  s ucces s ful ly  s ent?What happens  when an email  in the O utbox is  s ucces s ful ly  s ent?

A nsA ns 1. It remains in the Outbox indefinitely.

2. It moves to the Trash folder.

3. It is automatically deleted.

4. It moves to the Sent folder.

Q .65Q .65 Whic h of the fo l lowing protoc ols  is  c ommonly  us ed to  retr ieve emai ls  from aWhic h of the fo l lowing protoc ols  is  c ommonly  us ed to  retr ieve emai ls  from a
mail  s erver?mail  s erver?

A nsA ns 1. FTP

2. HTTP

3. SSH

4. POP3
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Q .66Q .66 _______ is  c ommonly  us ed for  s tor ing audio  data ,  s uc h as  mus ic  trac ks  or  audio_______ is  c ommonly  us ed for  s tor ing audio  data ,  s uc h as  mus ic  trac ks  or  audio
rec ordings .rec ordings .

A nsA ns 1. PDF

2. JPEG

3. MP3

4. XLSX

Q .67Q .67 Whic h of the fo l lowing s teps  s hould  be fo l lowed to  pr int  the c urrent s preads heetWhic h of the fo l lowing s teps  s hould  be fo l lowed to  pr int  the c urrent s preads heet
in M S  E xcel?in M S  E xcel?

A nsA ns 1. Edit > Print

2. File > Print

3. View > Print

4. Format > Print

Q .68Q .68 Whic h of the fo l lowing does  c y ber  s ec ur ity  NO T offer  as  a  benefit?Whic h of the fo l lowing does  c y ber  s ec ur ity  NO T offer  as  a  benefit?

A nsA ns 1. User privacy

2. Slowing down the system

3. Minimising crashes

4. Protection against viruses

Q .69Q .69

A nsA ns 1. 

2. 

3. 

4. 

Q .70Q .70 Rahul  entered his  date of birth,  1 4  Feb 2 0 0 9,  in an M S  E xcel  cel l .  He mis takenlyRahul  entered his  date of birth,  1 4  Feb 2 0 0 9,  in an M S  E xcel  cel l .  He mis takenly
c hanged the ty pe of cel l  in the Format C el ls  opt ion to  G eneral .  What wi l l  the cel lc hanged the ty pe of cel l  in the Format C el ls  opt ion to  G eneral .  What wi l l  the cel l
d is play  now?dis play  now?

A nsA ns 1. Any random number

2. Number of days elapsed since 01 Jan 1900

3. Number of days elapsed since 01 Jan 2009

4. Error
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Q .71Q .71 What is  the purpos e of us ing 'S ec t ion Breaks '  in M S  Word 2 0 1 9?What is  the purpos e of us ing 'S ec t ion Breaks '  in M S  Word 2 0 1 9?

A nsA ns 1. To highlight text

2. To add bullet points

3. To divide the document into sections for different formatting

4. To insert a new page

Q .72Q .72 Whic h of the fo l lowing meas ures  is  es s entia l  for  s ec ur ing a PC  and protec t ing itWhic h of the fo l lowing meas ures  is  es s entia l  for  s ec ur ing a PC  and protec t ing it
from c y ber  threats?from c y ber  threats?

A nsA ns 1. Only using the computer during daytime hours

2. Connecting to open Wi-Fi networks for easy internet access

3. Using strong, unique passwords for different accounts and changing them regularly

4. Disabling the firewall to increase system performance

Q .73Q .73 Whic h of the fo l lowing is  a  c harac ter is t ic  of  the L inux operat ing s y s tem?Whic h of the fo l lowing is  a  c harac ter is t ic  of  the L inux operat ing s y s tem?

A nsA ns 1. It is a closed-source operating system.

2. It is known for its stability and security.

3. It is based on the Windows kernel.

4. It is primarily used on Apple computers.

Q .74Q .74 Where c an a us er  pin frequently  us ed appl ic at ions  for  quic k  acces s  in M SWhere c an a us er  pin frequently  us ed appl ic at ions  for  quic k  acces s  in M S
Windows  1 0 ?Windows  1 0 ?

A nsA ns 1. System Properties

2. Control Panel

3. Taskbar

4. Device Manager

Q .75Q .75 Whic h of the fo l lowing key board s hortc uts  is  us ed for  moving the c urs or  oneWhic h of the fo l lowing key board s hortc uts  is  us ed for  moving the c urs or  one
word to  the left  in an M S  Word doc ument?word to  the left  in an M S  Word doc ument?

A nsA ns 1. Fn+Left arrow key

2. Shift+Left arrow key

3. Alt+Left arrow key

4. Ctrl+Left arrow key
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Q .76Q .76 Whic h of the fo l lowing is  a  s mal l  graphic al  repres entat ion of a  c omputerWhic h of the fo l lowing is  a  s mal l  graphic al  repres entat ion of a  c omputer
appl ic at ion on the des ktop?appl ic at ion on the des ktop?

A nsA ns 1. Notification

2. Icon

3. Taskbar

4. Start button

Q .77Q .77 Dis c arded emails  are s tored in whic h fo lder?Dis c arded emails  are s tored in whic h fo lder?

A nsA ns 1. Drafts folder

2. Sent folder

3. Trash folder

4. Spam folder

Q .78Q .78 Whic h of the fo l lowing options  in M S  Word is  us ed to  a l ign a  paragraph to  both,Whic h of the fo l lowing options  in M S  Word is  us ed to  a l ign a  paragraph to  both,
the left  and r ight  margins?the left  and r ight  margins?

A nsA ns 1. Left

2. Right

3. Center

4. Justify

Q .79Q .79 Whic h tab is  to  be us ed to  c hange the template of an exis t ing M S  PowerPointWhic h tab is  to  be us ed to  c hange the template of an exis t ing M S  PowerPoint
pres entat ion?pres entat ion?

A nsA ns 1. Home

2. Design

3. Transitions

4. Insert

Q .80Q .80

A nsA ns 1. 

2. 

3. 

4. 

Section : Quantitative Aptitude
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Q .81Q .81 The pres ent ages  of S  and T  are 70  y ears  and 50  y ears ,  res pec t ively .  How manyThe pres ent ages  of S  and T  are 70  y ears  and 50  y ears ,  res pec t ively .  How many
y ears  ago was  the rat io  of  their  ages  1 1  :  7?y ears  ago was  the rat io  of  their  ages  1 1  :  7?

A nsA ns 1. 18

2. 15

3. 14

4. 12

Q .82Q .82

A nsA ns 1. 
           

2 . 
            

3. 
           

4. 

Q .83Q .83 The average of the marks  of 1 5 s tudents  in a  c las s  is  4 6 .  I f  the marks  of eac hThe average of the marks  of 1 5 s tudents  in a  c las s  is  4 6 .  I f  the marks  of eac h
s tudent are doubled ,  find the new average?s tudent are doubled ,  find the new average?

A nsA ns 1. 92

2. 30

3. 46

4. 15

Q .84Q .84 The average of 24  numbers  is  75.  The average of the firs t  1 2  numbers  is  72  andThe average of 24  numbers  is  75.  The average of the firs t  1 2  numbers  is  72  and
the average of the las t  1 3  numbers  is  80 .  I f  the 1 2the average of the las t  1 3  numbers  is  80 .  I f  the 1 2 t ht h  number is  exc luded ,  then number is  exc luded ,  then
what wi l l  be the average of the remaining numbers  ( rounded off to  two dec imalwhat wi l l  be the average of the remaining numbers  ( rounded off to  two dec imal
places) ?places) ?

A nsA ns 1. 73.74

2. 75.68

3. 74.82

4. 76.24
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Q .85Q .85

A nsA ns 1. 6.88

2. 8.96

3. 8.66

4. 9.68

Q .86Q .86 A rindam purc has ed a c oat  for  ₹2 ,1 0 0  after  gett ing a d is c ount of 2 0 % but thenA rindam purc has ed a c oat  for  ₹2 ,1 0 0  after  gett ing a d is c ount of 2 0 % but then
paid  G S T at  a  rate of 5% on the d is c ounted pr ice.  F ind the marked pr ice of thepaid  G S T at  a  rate of 5% on the d is c ounted pr ice.  F ind the marked pr ice of the
c oat .c oat .

A nsA ns 1. ₹2,500

2. ₹2,480

3. ₹2,520

4. ₹2,490

Q .87Q .87 3  y ears  ago ,  the average age of A ,  B,  and C  was  3 2  y ears .  3  y ears  from now,  the3  y ears  ago ,  the average age of A ,  B,  and C  was  3 2  y ears .  3  y ears  from now,  the
average age of A  and C  wi l l  be 43  y ears .  What wi l l  be the age ( in y ears)  of  B,  4average age of A  and C  wi l l  be 43  y ears .  What wi l l  be the age ( in y ears)  of  B,  4
y ears  from now?y ears  from now?

A nsA ns 1. 31

2. 30

3. 25

4. 29

Q .88Q .88 The length of a  rec tangle was  dec reas ed by  2 0 %.  I f  its  breadth is  inc reas ed byThe length of a  rec tangle was  dec reas ed by  2 0 %.  I f  its  breadth is  inc reas ed by
3 5%, then by  what percentage wi l l  the area of the rec tangle c hange?3 5%, then by  what percentage wi l l  the area of the rec tangle c hange?

A nsA ns 1. 8% decrease

2. 8% increase

3. 10% increase

4. 10% decrease
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Q .89Q .89 In an elec t ion of 3  c andidates ,  A l ice,  Bob,  and C har l ie,  A l ice gets  50 % more votesIn an elec t ion of 3  c andidates ,  A l ice,  Bob,  and C har l ie,  A l ice gets  50 % more votes
than Bob.  A l ice beats  C har l ie by  72 ,0 0 0  votes .  Bob gets  2 0 % more votes  thanthan Bob.  A l ice beats  C har l ie by  72 ,0 0 0  votes .  Bob gets  2 0 % more votes  than
C har l ie .  80 % of the total  voters  on the vot ing l is t  c as t  their  votes ,  and no votesC har l ie .  80 % of the total  voters  on the vot ing l is t  c as t  their  votes ,  and no votes
were i l legal .  F ind the total  number of voters  on the vot ing l is t .were i l legal .  F ind the total  number of voters  on the vot ing l is t .

A nsA ns 1. 4,36,000

2. 4,23,229

3. 4,23,329

4. 4,50,000

Q .90Q .90 A  man s pends  64% of his  inc ome.  I f  his  inc ome inc reas es  by  2 5% and hisA  man s pends  64% of his  inc ome.  I f  his  inc ome inc reas es  by  2 5% and his
expenditure inc reas es  by  1 0 %, then what is  the percentage inc reas e ( rounded offexpenditure inc reas es  by  1 0 %, then what is  the percentage inc reas e ( rounded off
to the s ec ond place of dec imal)  in his  s av ings?to the s ec ond place of dec imal)  in his  s av ings?

A nsA ns 1. 57.67%

2. 51.67%

3. 53.67%

4. 56.67%

Q .91Q .91 A  man c an row a boat  ups tream at  8  km/ hr  and downs tream at  1 2  km/ hr.  F indA  man c an row a boat  ups tream at  8  km/ hr  and downs tream at  1 2  km/ hr.  F ind
the rat io  of  the s peed at  whic h the man c an row the boat in s t i l l  water  to  thethe rat io  of  the s peed at  whic h the man c an row the boat in s t i l l  water  to  the
s peed of the c urrent .s peed of the c urrent .

A nsA ns 1. 2 : 5

2. 5 : 2

3. 1 :  5

4. 5 : 1

Q .92Q .92 If  4% of x  =  24 0 ,  then x  is  equal  to :I f  4% of x  =  24 0 ,  then x  is  equal  to :

A nsA ns 1. 12000

2. 6100

3. 12100

4. 6000
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Q .93Q .93 The or iginal  pr ice of a  mus ic  s et  is  ₹8 ,1 0 0 .  The pr ice is  d is c ounted by  1 2 % andThe or iginal  pr ice of a  mus ic  s et  is  ₹8 ,1 0 0 .  The pr ice is  d is c ounted by  1 2 % and
then rais ed by  2 5%.  What is  its  new pr ice ( in ₹) ?then rais ed by  2 5%.  What is  its  new pr ice ( in ₹) ?

A nsA ns 1. 8,410

2. 8,910

3. 9,410

4. 8,210

Q .94Q .94 A  boat c an run with a  s peed of 1 3  km/ hr  in s t i l l  water.  I f  the s peed of the s treamA  boat c an run with a  s peed of 1 3  km/ hr  in s t i l l  water.  I f  the s peed of the s tream
is  4  km/ hr,  then find the t ime taken by  the boat  to  c over  68 km downs tream.is  4  km/ hr,  then find the t ime taken by  the boat  to  c over  68 km downs tream.

A nsA ns 1. 4 h

2. 5 h

3. 3 h

4. 2 h

Q .95Q .95 A  s mal l  pipe fil ls  up a tank  in 6  hours ,  whi le a  big pipe works  50 % fas ter.  I f  thereA  s mal l  pipe fil ls  up a tank  in 6  hours ,  whi le a  big pipe works  50 % fas ter.  I f  there
are 3  s mal l  pipes  and 2  big pipes ,  how long wi l l  i t  take to  fil l  up the tank?are 3  s mal l  pipes  and 2  big pipes ,  how long wi l l  i t  take to  fil l  up the tank?

A nsA ns 1. 40 minutes

2. 1 hour 20 minutes

3. 1 hour

4. 30 minutes

Q .96Q .96 A  s hopkeeper  l is ts  the pr ice of a  fan at  50 % above its  c os t  pr ice and offers  aA  s hopkeeper  l is ts  the pr ice of a  fan at  50 % above its  c os t  pr ice and offers  a
2 9% dis c ount on its  l is t  pr ice.  I f  he earns  a  profit of ₹1 95,  then what is  the l is t2 9% dis c ount on its  l is t  pr ice.  I f  he earns  a  profit of ₹1 95,  then what is  the l is t
pr ice ( in ₹)  of  the fan?pr ice ( in ₹)  of  the fan?

A nsA ns 1. 4,460

2. 4,500

3. 4,380

4. 4,525
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Q .97Q .97

A nsA ns 1. 

2. 

3. 

4. 

Q .98Q .98 Whic h of the fo l lowing frac t ions  is  the larges t?  Whic h of the fo l lowing frac t ions  is  the larges t?  

A nsA ns 1. 

2. 

3. 

4. 

Q .99Q .99 Find the s ingle percentage d is c ount [c orrec ted to  1  dec imal]  equivalent  to  threeFind the s ingle percentage d is c ount [c orrec ted to  1  dec imal]  equivalent  to  three
s ucces s ive d is c ounts  of 83 %, 64%, and 79% res pec t ively .s ucces s ive d is c ounts  of 83 %, 64%, and 79% res pec t ively .

A nsA ns 1. 

2. 

3. 

4. 

Q .1 0Q .1 0
00

L ewis ,  M ic hael ,  and C har les  c an finis h a  certain piece of work  in 8 ,  4 6 ,  and 24L ewis ,  M ic hael ,  and C har les  c an finis h a  certain piece of work  in 8 ,  4 6 ,  and 24
day s ,  res pec t ively .  A l l  three of them s tarted the work  together.  L ewis  left  theday s ,  res pec t ively .  A l l  three of them s tarted the work  together.  L ewis  left  the
work  after  2  day s  and M ic hael  left  jus t  4  day s  before the work  was  c ompleted .work  after  2  day s  and M ic hael  left  jus t  4  day s  before the work  was  c ompleted .
Find the total  number of day s  taken for  the work  to  be c ompleted .Find the total  number of day s  taken for  the work  to  be c ompleted .

A nsA ns 1. 8.7

2. 12.4

3. 13.2

4. 3.9
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